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1. ���������  �����	����  

�����  �����	
��� : 
��������  �  Intel® Pentium IV-��	��������  �����������  
 
�
��
����
 : ����
�����
�  ������
  Windows 2000/NT/XP/Vista ���  Windows 2003 

Server 
 
����������  IWS: ����
�����
�  ������
  Windows 2000/NT/XP/Vista 
 
����������  CE View: ����
�����
�  ������
  Windows CE v3.0, Windows CE.Net. 

���  ���������
 , ��������	
����  IWS (���������  ����  �����������  
<InduSoft Web Studio Folder>\Redist\<OS Version>\<Processor Type>\ ) 

 ������  ������ : MS Internet Explorer 6.0 ���  	� �  
 
 

2. �����

����  IWS 
�
��
����
  �  ����������  IWS: IWS �����  ���
��	���  �  �������  ���
��	����!�  

����
  ��� , ��
�
	  "
���  ���  ����
������  �
  �
���  (http://www.InduSoft.com). 
#
�������  ���
��	��  ������ . $�������  �����������  ��
�
����  	  ��
��!�  
InstallShield Wizard. % ��
��!�  ���
��	���
  �����  ����������  	���
��  
&�������  ��  �����
 , �������  �����  ���
��	����  �
  	
  ��������� : 



 
 '����  �
	�� ����  ���
��	��  �����
!������  ��������� . 
 
����������  CE View: '����  ���
��	��  IWS ���  Windows, "
���  ����(������  

���  ���
��	��  IWS ���  CE �
(������  	   <InduSoft Web Studio 
Folder>\Redist\<OS Version>\<Processor Type>\  
)��
��	�
 :  
1) '��  	��������  WinCE ��������	
 , 
	���
�������  �
����
����  Remote 

Agent ��
��! . *���  ��  ��  ���  �
�� ��  
	���
������� , ����(�����  
�������	
��  "
��  CESERVER.EXE ��  �
���  <InduSoft Web Studio 
Folder>\Redist\<OS Version>\<Processor Type>\ �
  ���������� , �  
���
��	������  IWS, 	  �
���  �
  WinCE )�������	� , �  �
�������  �!� . 

2) $���
��  ����������  �����  WinCE ��������	��  �  �����������  �  IWS, 
���������  Remote Agent->Setup (�������������  TCP/IP ���������� ). 

3) +
  ����������  �  Windows �
�������  IWS 
4) +
  �
����  ���
	�����  	���
��  Project->Execution Environment  
5) % ,�
��!�  Execution Environment 	���
��  ���  ����������  �  WinCE 

��������	�� , �
���  �
�
��  ������  Connect. 
6) +
�
��  ������  Install System Files ���  ���
��	��  "
���	  �
  WinCE 
��������	� . 

*���  ���������
  ��������	
  �  Windows CE, ����	����	���  ����������  ��  �
���  
<InduSoft Web Studio Folder>\Redist\<OS Version>\<Processor Type>\ 
 
 

3. ����  
������� , �����������  ��  ����
���	����  



 CEView  
Lite 

Lite 
Interface  

CEView 
Standard  

Local 
Interface  

CEView 
Professional  

Operator 
Workstation  

Control  
Room 

Advanced 
Server 


�������
�������  
��
�	��� , 
����	�������  

1 1 3 3 5 5 8 +�  
�!�
������  


�� -	�  �&!�	  
(�����  		��
  
	�	��
  + 
���������� ) 

150 150 1500 1500 4000 4000 64000 512000 

&�������	  	  
�
���	�  

- - 256 256 512 512 1024 16348 

�����	  
	  ��
���  

- - 32 32 32 32 64 512 

Recipe - - + + + + + + 
Report - - + + + + + + 
ODBC - - + + + + + + 
DDE Client / Server - - + + + + + + 
Group of screens - + + + + + + + 
Picture (Paste Link) - - + + + + + + 
Dynamics - - + + + + + + 

 
 
4. ����	����  
�������  

�
��
����
 , ����������  IWS HardKey: )��
��	���  ����  (USB ���  LTP) �  
�
�������  ������ . ,��  
���	
��� : Start -> Programs -> InduSoft Web Studio -
> Register  	���
��  HardKey. 

,��  ���������  ��������  �
�����  Check (	  ���	�	 ����  ����  �����  
���	�����  	��  �
�
�����  �������  �������� ) –> Change License, ����������  
���  ��  ����  Site Code �  ����
	���  �!�  ����
	����  '� . % ��	��  	�  ��������  
���� , �������  ����(�����  		����  	  ����  Site Key . '����  ���� ���  

	�����
���  �����  �������
  ��	
�  �������� . 

 
�
��
����
 , ����������  SoftKey: #
�������  	���������  ������  ��!����
��� : 

Start -> Programs -> InduSoft Web Studio -> Registe r , 	�������  SoftKey �  
�
�����  Check. *���  �
  ����������  ��  ���
  ���
��	���
  �������� , 	  
���	�	 ����  ����  	  ����  Status �����  �
���
��  License not found (��
��  
�
�
�����  �������  �������� ). +
�����  Change License , ����������  ���  ��  
����  Site Code �  ����
	���  �!�  ����
	����  '� . % ��	��  	�  ��������  ���� , 
�������  ����(�����  		����  	  ����  Site Key . '����  ���� ���  
	�����
���  
�����  	�	�����  �
  &��
�  ���������  ��  ���� ���  ����
������  �������� . 

 
����������  CE View: 2 ������
  
���	
���  �������� : 

1) -��
���� . +
  WinCE ��������	�  �
�������  Remote Agent ��
��! -> Setup 
->Change License. % ���	�	 ����  ����  	  ����  Status �
�����  Change 
License -> ����������  ���  ��  ����  Site Code �  ����
	���  �!�  ����
	����  
'� . % ��	��  	�  ��������  ���� , �������  ����(�����  		����  	  ����  Site 
Key. '����  ���� ���  
	�����
���  �����  	�	�����  �
  &��
�  ���������  
��  ���� ���  ����
������  ��������  

2) )�
����� . +
   WinCE ��������	� , �
�������  Remote Agent ��
��!  -> 
Setup. $���
���  ����������  �����  WinCE ��������	��  �  �����������  �  
IWS (�������������  TCP/IP ���������� ). +
  ����������  �  Windows 
�
�������  IWS. +
  �
����  ���
	�����  	���
��  Project->Execution 
Environment.  % ,�
��!�  Execution Environment 	���
��  ���  ����������  
�  WinCE ��������	�� , �
���  �
�
��  ������  Connect. %�������  	��
���  
CE License  -> ����������  ���  ��  ����  Site Code �  ����
	���  �!�  



����
	����  '� . % ��	��  	�  ��������  ���� , �������  ����(�����  		����  	  
����  Site Key . '����  ���� ���  
	�����
���  �����  	�	�����  �
  &��
�  
���������  ��  ���� ���  ����
������  �������� . 

 
 

5. ����  ����������  
Integer: .��������  ��
����� . 32 bit ��  ��
���  
String: ������	��  ��
����� . /
����
���
�  ����
  1024 ���	��
   
Real: ���������  ��
�����  �  ��
	
����  �
����� . 
Boolean: ���������  ��
�����  0 �  1 

 
 
6. ���������  ��
��  ���������� . �	����	�  ����������  

'���  ����������  – �
���  �	����	 , �������(  �
����  ��  �
�����  ���������( . 
$���
����  ���  ��������
  �	����	  ���������� : <Tag Name> -> <Field Name> 
 

�
����
  �����  ���������(  
'���  
����������  

����
���  Bool Int Real Str R
/
R
W 

Name ���  ���������� , �"������	
����  	  
���������� . 

Y Y Y Y R 

MemberName ���  ����
  ��
��
   
$���
����  <Class>.<Member>->MemberName 

Y Y Y Y R 

Index ������  &���
��
   
���������  <Tag>[<Index>]->Index Y Y Y Y R 

Description ����
���  ��������� . 0����������  	  Tags 
datasheet. Y Y Y Y R 

Max /
����
�����  ��
����� , �������  �����  
������
��  ��������
�  	  runtime. 

N Y Y N R
W 

Min /����
�����  ��
����� , �������  �����  
������
��  ��������
�  	  runtime. 

N Y Y N R
W 

Quality 

«

����	� » ����������  (192=GOOD; 0=BAD). 
IWS ����	����  &��  ���� , �
����  �
�  ���  
����	�����  ����������  �������
�
  
	���������  	��
�����  ���  �
�
�  (�
��(  �
�  
driver ���  OPC). 

Y Y Y Y R 

Size 
�
���������  �
���	
 . *���  ��������
�  ��  
�	������  &��������  �
���	
 , ����  �����  
��
�����  0. 

Y Y Y Y R 

TimeStamp ,
�
  �  	����  ��������!�  ���������  ��
�����  
���������� . 

Y Y Y Y R 

Unit *������  ���������  ����������  (��  �����  9 
���	���	 ).  +
������   "Kg" 

Y Y Y Y R
W 

B0 … B31 #�
�����  (0 ���  1) ����!�  ��  32 bits (b0, b1, 
b2, … b31) ����������  ���
  int. N Y N N R

W 

AlrStatus .��������  ��
����� , �	��
����  �  
���	���� , 
�
  �
����  ������ , 
�
��
��  ��
�
����  Y Y Y N R 



���������� . 

����  ���  &��!�  �����	�!�  
�������
�
  ����	����	���  �������������  
��
���� : 
Bit 0: HiHi Alarm 
���	��  
Bit 1: Hi Alarm 
���	��  
Bit 2: Lo Alarm 
���	��  
Bit 3: LoLo Alarm 
���	��  
Bit 4: Rate Alarm 
���	��  
Bit 5: Deviation+ Alarm 
���	��  
Bit 6: Deviation- Alarm 
���	��  
 
'����� : *���  Tag->AlrStatus 	��	�
�
��  
��
�����  2, &��  ���
�
��  "Hi" 
�
��  
���	�� . 
*���  	��	�
�
��  ��
�����  3, ��
���  
����	��������  
���	��  
�
���  "HiHi"  �   "Hi". 
 
*���  ��
�����  &��!�  ����  0, &��  ���
�
��  
�������	��  
�
���	  &���  ���������� .  

,��  ���������(  ���
  Boolean, ��!��  ����  
��������  ������  ��
�����  1 (bit 1), 4 (bit 2) 
��� 16 (bit 4). 

Ack 

1��  ����  �����  ������
��  ��
�����  0 �  1: 
0: +��  
�
���	 , �	��
���(  �  ��
�
����   
���������� , ����
���(��  	  ����	�������� ; 
1: *���  (���  ��  ����  ������	���������  

�
�� , �	��
����  �  ��
�
����  ���������� . 
 
NOTE: #�
�����  0 �����  ������  	  ����
�  
����	��������  	��(  
�
���	 , �	��
���(  �  
��
�
����  ���������� .  

Y Y Y N R 

AlrDisable 

1��  ����  �����  ������
��  ��
�����  0 �  1: 
0: ,�������  2�
���  �	��
����  �  ���������� . 
'��  ����������  
	
�����!�  ��
����� , 
�
��  
��
���  
���	��� . 
1: 2�
���  �	��
����  �  ����������   ��  
�������� . '��  ����������  
	
�����!�  
��
����� , 
�
��  ��  ��
���  
���	��� . 

Y Y Y N 
R
W 

HiHi 0 – HiHi alarm ��  
���	�� , 1 - HiHi alarm 

���	��  Y Y Y N R 

Hi 0 – Hi alarm ��  
���	�� , 1 - Hi alarm 
���	�� . Y Y Y N R 

Lo 0 – Lo alarm ��  
���	�� , 1 - Lo alarm 
���	��  Y Y Y N R 

LoLo 0 – LoLo alarm ��  
���	�� , 1 - LoLo alarm 

���	��  

Y Y Y N R 

Rate 0 – Rate alarm ��  
���	�� , 1 - RateLo alarm 

���	��  

Y Y Y N R 

DevP 0 – DevP alarm ��  
���	�� , 1 – DevP alarm 

���	�� . 

N Y Y N R 

DevM 0 – DevM alarm ��  
���	�� , 1 – DevM alarm N Y Y N R 




���	�� . 

HiHiLimit 3�
���
  	�������	����  HiHi alarm. N Y Y N R
W 

HiLimit 3�
���
  	�������	����  Hi alarm. N Y Y N R
W 

LoLimit 3�
���
  	�������	����  Lo alarm. N Y Y N R
W 

LoLoLimit 3�
���
  	�������	����  LoLo alarm. N Y Y N R
W 

RateLimit 3�
���
  	�������	����  Rate alarm. N Y Y N R
W 

DevSetpoint )��
	�
  ���  	�������	����  Deviation alarms. N Y Y N R
W 

DevPLimit 3�
���
  	�������	����  DevP alarm. N Y Y N R
W 

DevMLimit 3�
���
  	�������	����  DevM alarm. N Y Y N R
W 

 
$	����	
  ���������(  

'���  
����������  

����
���  Bool Int Real Str 

Retentive 
Value 

$�(�
�����  ��
�����  ���������� , 	  ����
�  
���
��	��  ���������� . 

Y Y Y Y 

Retentive 
Parameters 

$�(�
�����  ��
�����  �����  ���������(  Y Y Y Y 

Startup 
Value 

$�
���	��  ��
�����  ����������  ���  �
�����  
����������  (����  ��  
���	��  Retentive Value) Y Y Y Y 

Unit 
�
����  �������
���  �  ����������  (�������  
��������� ) 

Y Y Y Y 

Max, Min /
����
����� , �����
�����  ��
����� , 
�������  �����  ������
��  ��������
� . 

N Y Y N 

Dead Band %������
  ����������  ��  ��
�����  ���������� , 	  
������
(  �������  ��  "����������  
�
��  

N Y Y N 

Smoothing )���������  ���������  ��
�����  ����������  
(���  ���	��  �����	
���  tag=50, ���  ���������  
Tag=60, ��!�
  ��	��  ��
�����  (50+60)/2 tag=55) 

N Y Y N 

 
Web Data �	����	
  ���������(   
'���������  ��!��  ����  2-����	 : Local �  Server.  
'��  ���
�����  �����(  �������	  �  �����  �  ���  ��  ����������  ���
  Local ��
  
������
��  �
�������  ��
�����  ���  �
���(  �����(  �������	 , ���
	������  ���!  ��  
���!
 .  #�
�����  ����������  ���
  Server ����
��	��  ���  	��(  �����(  �������	 . 
 
 

7. �����	�  �  �
����  
/
���	  – !����
  ���������(  ����!�  ���
 . �����
����� : 
<ArrayTagName>[ArrayIndex]. �
���������  �
���	
  [nx1]. �!�
�������  �
  
��������	�  &�������	  �
���	
  ��!�
���  ����  �������� . 



 

�
��  – ��4��������  ���������( , ������(  ����
��	��  �	����	
 . '��������(  
	  ������
(  ����!�  ��
��
  ��!��  ����  �
���(  ����	 . /����  ����
	
��  �
���	�  
��
���	 . �����
����� : <ArrayClassName>[<ArrayIndex>].<Member.Name>. 
�!�
�������  �
  ��������	�  &�������	  ��
��
  ��!�
���  ����  �������� . 
 
 

8.  ���������  ����  Inderect 
Inderect tag – ���������� , ��������	
����  ���	�����  ������  �  ���!��  
���������� . '�������
� , ����������
�  �
�  Inderect, �����
  ����  ���
  string. 
,��  ���	����!�  ���
�����  �  ���������� , ����(�����  ����	����  ��
�����  
�
	���  �
�	
���  ���  ���������� , �  �������  ����  ���
����� , ����������  
������������  �
�  Inderect, 
  �
���  ��������  ������ , ���������  ���	��  @. 
'����� :  Tag=10 

InderectTag=”tag” 
'�������  ��
�����  ����������  Tag: value=@InderectTag => value=10 
#
���
��  ��
�����  	  ����������  Tag: @InderectTag=15 => Tag=15 

 
 

9. !�
���  Alarm 
0������	
���  
	
�����(  ���������  ���  ����������  ���������� , ���  �������  
�"������	
�  
�
�� , ���������!�  ��
����� . 
 
%��  �
�����  �
�
��  
�
���	  (Alarm worksheet) 

 
 
'���  ���
���  Header �
�����  Alarm worksheet 

 �
�  "�������  
Description ����
���  �
�����  

Group Name 
+
�	
���  !�����  
�
���	 . ������������  	  �
����	�  
"�����
  
�
���	  	  ��4����  Alarm/Event control ���  
�
��������  ����������  (runtime). 

Email Settings 

+
������� , ���  
	���
��������  ����
	��  Email , 
������
��(  
	
������  ��������� . '��  
��������	
���  
	���
��������  ����
	��  email, 
�
�
���  	  �������  ����(�����  	��������  "������  
�
�������  �
�
�����	  SMTP ��������
  ( CnfEmail()  ) 



Advanced ,�������������  	����������  �
�
��  Alarm (�����  
��������  �
���������  ���� ). 

On Line  
> Display in Alarm Controls  

�����
�����  
�
���	  	  ��4����  Alarm/Event control 

On Line 
> Ack Required 

+���(��������  ����	��������  
���	��(  
�
���	  	  
��4����  Alarm/Event control. 

On Line 
> Beep 

#	���	��  ���	������  ���  ������	�	
���  
���	��(  

�
���	 . 

On Line 
> Send to Printer 

%�	��  �
  ���
��  
	
�����!�  ���������  ���  
	�������	����  
�
��
 . $��������  �����  �
����
�
��  
�
  �������� , 	���
�����  ��  �����
��� . ,��  	�	��
  
�
  ���
��  �  ���!�!�  �������
 , ����(�����  ��
�
��  ����  
�  ����  	  "
���  <ApplicationName>.APP: 

[AlarmLog] 
Device=<PrinterPath/PrinterName> 

History  
> Save to Disk 

$�(�
�����  
	
�����(  ���������  �
  ����  	  	���  
"
���	  (ALyymmdd.ALH). 

History  
> Generate Ack Messages 

0������	
���  ���������  �  ����	��������  
���	��!�  

�
��
  �  ��(�
�����  	  "
�� . 

History  
> Generate Norm Messages 

0������	
���  ���������  �  ����
���
���  ��
�����  
���������� , ���  �������  ��
���
�  
�
��  �  
��(�
�����  	  "
�� . 

Colors in Alarm Controls  5	���	
�  �����
���  
	
�����(  ���������  	  ��4����  
Alarm/Event control. 

 
'���  ���
���  Body �
�����  Alarm worksheet 

 �
�  "�������  ���������  

Tag Name +
�	
���  ���������� , ���  �������  "����������  

�
�� . 

'�������
�  
������  

Type 

����  
�
���	 : 

·  HiHi: 2�
��  
���	��  ���  ��
�����  ����������  
>= ��
�����  ������
 .  

·  Hi: 2�
��  
���	��  ���  ��
�����  ����������  >= 
��
�����  ������
 . 

(Tag: Hi limit=3 ->Msg1, HiHi limit=5 ->Msg2  =>����  
Tag=4 ���������  «Msg1», Tag>5 ���������  «Msg2»)   

·  Lo: 2�
��  
���	��  ���  ��
�����  ����������  <= 
��
�����  ������
 .  

·  LoLo: 2�
��  
���	��  ���  ��
�����  ����������  
<= ��
�����  ������
 .  

·  Rate: 2�
��  
���	��  ���  ���������  ��
�����  
����������  �������  �
�
����  ��������  (Limit/s, 
min ���  hour – 	����
����  	  �	����	
(  
���������� ) 

·  DevP: 2�
��  
���	��  ���  ���������  ��
�����  

Combo-box 



����������  �
  	�������  > ��
�����  ������
  + 
��
�����  ���
	��  (Set Point Deviation).  

·  DevM: 2�
��  
���	��  ���  ���������  ��
�����  
����������  �
  	�������  > ��
�����  ������
  - 
��
�����  ���
	��  (Set Point Deviation)..  

'��  ��������	
���  ����	  
�
���	  Rate, DevP �  DevM, 
����(�����  "������	
��  ��������������  ����	��  	  
�
������
(  ����������  (Tag Properties dialog). 

Limit 

 '���������  ��
�����  ���������( , ����	����	�����  
	�������	����  
�
��
 . '������  ��!��  ����������  �  	  
��������  �
����  ����������  (runtime), ���������  
����  ���������(   HiHiLimit, HiLimit, LoLimit, LoLoLimit, 
Rate, DevP �  DevM (������ : TagLevel->HiLimit). 

�����  

Message 
2	
������  ��������� , �����
�
����  	  ��4����  
Alarm/Event control, ��(�
������  	  .alh "
��  �  
����
	������  ��  email. 

�����  � /���  
{Tag} (��  �����  
256 ���	���	 ) 

Priority 
#�
�����  ���������
 , ��  ��������  �����
	
����  
�����  "������	
��  � /���  �������	
��  
�
���  	  
��4����  Alarm/Event contro. 

.����  
(��  0 ��  255) 

Selection 
������	��  ��
����� , ��  ��������  �����
	
����  �����  
"������	
��  � /���  �������	
��  
�
���  	  ��4����  
Alarm/Event contro. 

�����  
(��  �����  7 
���	���	 ) 

 
 
Advanced 

 
 
 

Field Remarks Syntax 

Disable '��  ��
�����  ����������  	  &���  ����  <> 0, 
�
���  
�
����  !����� , ��  "����������  Tag 

Total Alarms #�
�����  ���������� , ��
�
����  	  &���  ���� , �
	��  
�����  
���	��(  
�
���	  �
����  !����� . 

Tag 

Total Unack 
#�
�����  ���������� , ��
�
����  	  &���  ���� , �
	��  
�����  ������	��������(  
���	��(  
�
���	  �
����  
!����� . 

Tag 



Remote Ack Trigger 
'��  ���������  ��
�����  ���������� , ��
�
����  	  
�
����  ���� , ����	����
����  	��  
���	���  
�
���  
�
����  !����� . 

Tag 

Dead Band Time  
> Activation 

#
�����
  ��  	������ , ���  "������	
���  
���������  �  	�������	����  
�
��
 . 

Tag ���  
�����  

Dead Band Time  
> Normalization 

#
�����
  ��  	������ , ���  "������	
���  
���������  �  ����
���
���  
�
��
 . 

Tag ���  
�����  

Dead Band Time  
> Time Stamp/Value 

)�
�
���  	������  (time stamp) 	�������	����  
(����
���
��� ) 
�
��
 . )���	��  ����	�����  time 
stamp: 

·  Activation/Norm (default): %����  (�  ������  
�
������ ) 	�������	����  (����
���
��� ) 

�
��
 .  

·  Last Tag Change: %����  ���������  ��
�����  
����������  	  �������  �
������  
	�������	����  (����
���
��� ) 
�
��
 .  

·  Start Condition: %����  (���  ����
  �
������ ) 
	�������	����  (����
���
��� ) 
�
��
 . 

Combo 

 
'����������������  (�
�����  �������  
�
���	  (.alh "
���	 ) ��
��	
����  	  
Project > Settings > Options Tab ->  Alarm History and Events-> History Life Time 
(days).  
�!�
�������  ���  �
�
��  Alarm: 
/
����
�����  ��������	�  �
����  (Alarm worksheet) – 255 
/
����
�����  ��������	�  �����  	  �
�����  (Alarm worksheet) – 32000 
 
 

10. !�
���  Trend 
0������	
���  �����
  �����  – ��
�����  ���������( , 	  �
�������  �������  
	������ , 	  "���
��  .hst "
��
  ���  �
��  �
���( . 
 
����
���  �
�����  �
�
��  �����
  (Trend WorkSheet) 

 
 
'���  ���
���  Header �
�����  ����
   
History Format : 



·  Database. $�(�
�����  �����
  	  	���  �
��  �
���(  (6, ). +
�������  6,  
��������  	  ��
��!�  Database Cnfiguration 

·  Proprietary. $�(�
�����  �����
  	  	���  "
��
  "���
�
  GGYYDDMM.HST 
Advanced: ��������������  �
�������  �
�
��  �����
  

 
 

'���  �
�������  Bach "
��
  
·  Start/Stop : ���  ��  ����	��  ��
�����  ����������  	  �
����  ���� , IWS �����  

���
	����  ��	��  ��
�����  	  Bach-"
��  (	  ����
�  	����
   Proprietary) ���  
Bach-�
�����  (	  ����
�  	����
   Database) 

·  Name: '���  �  Bach-"
���  ( �
�	
���  Bach-�
����� ) 
·  Delete: ���  ���������  ��
�����  ����������  	  �
����  ���� , IWS ��
���  

Bach-"
��  (����  	  Bach-�
����� ) 
·  Existent :  ��������
� , �
���
��
�  	  �
����  ���� , ������  ��
�����  1, ����  

Bach-"
��  ���  ������	��� , 	  �����	���  ����
�  – 0 
·  Description : (��������  ���  	�����  Database) '��  ��  ����	��  ��
�����  

����������  	  ����  Start/Stop ��
����� , ���
	������  	  Bach-�
����� , 
�����
���  ����� , �"������	
����  	  &���  ���� . 

·  Save data even if batch is not running: ����  �	����	�  ��  �����  	���
�� , 
�
����  �����  ��(�
������  ������  ���  ��  ����	��  ��
�����  ����������  	  
����  Start/Stop 

 
'���   Disk Space Control 

·  History Life Time (days):  
�������	�  ���� , ���  (�
�����  "
���	  �������  
������	 . 

·  Compress After (days): 
�������	�  ���� , �����  ������(  IWS «������ » 
"
���  �������  ������	 , ���  ��	���������  ����
  �
  ����� . 

 
Disable All Data Saving: ���  ��  ����	��  ��
�����  ����������  	  �
����  ���� , 

IWS �
����
��  ��(�
�����  �������  ������	  
 
'���  ���
���  Body �
�����  ����
   

·  Tag Name: �
�	
���  ���������� , ���  �������  "����������  �����  
·  Dead Band : (��������  ���  	�����  Proprietary ) ���  ���������  ��
�����  

����������  �
  	�������  ���� ��  ��
�����  	  �
����  ���� , �
����  ��  
��(�
������  	  "
��  ����� . 

·  Field : (��������  ���  	�����  Database) �
�	
���  ����  �
�����  6, , 	  
�������  �����  ��(�
����  ��
�����  ���������� . 



 
Save on Trigger: #�
�����  ���������(  �����  �
���
��  	  ����� , ���  ���������  
���������� , ��
�
����  	  �
����  ���� . 
 
Save on Tag Change: '��  ���������  ��
�����  ����������  ��  �����
 , �
����  
�����  ��(�
����  	  "
��  �����
 . 
 
�!�
�������  ���  �
�
��  Trend: 
/
����
�����  ��������	�  �
����  (Trend worksheet) – 999 
/
����
�����  ��������	�  �����  	  �
�����  (Trend worksheet) – 240 
 

11. !�
���  Recipe 
�����  �
�����  �����  �����������  IWS �  "
��
��  	  ASCII ���  DBF "���
�� . 
 
����
���  �
�����  �
�
��  ������
  (Recipe WorkSheet) 

  
File Name: '���  �  "
��� , �  �������  �����  �����	����  �����  �
�����  
(��(�
�����  ���  �
���� ). '���  �����  ����  �"������	
�  �
�  ��������
�  {pathTag}. 
0
��  �����  ����  ��(�
���  	  "���
��  XML (Save as XML) ���  Unicod. 
Tag Name: #�
�����  ���������� , �������  �����  ��(�
����  	  (�
!������  �� ) 
"
��  
Number of Elements: % ����
�  ����  �����  ��(�
����  (�������� ) �
���	  
���������( , 	  �
����  ����  ��
��	
����  ��������	�  &�������	  �
���	
  (�
���
�  
�  0-!� ) 
 

��
���  ���  �
����  �  �������� : 
Recipe( "Save:Recipe1" ) – ��(�
����  ������  
Recipe( "Load:Recipe5" ) – �
!������  ������  
 
�!�
�������  ���  �
�
��  Recipe: 
/
����
�����  ��������	�  �
����  (Recipe worksheet) – 32000 
/
����
�����  ��������	�  �����  	  �
�����  (Recipe worksheet) –  ��  �!�
������  
 
 

12. !�
���  Report 
0������	
���  ������	  	  "���
��  ASCII ���  RTF. 
 
����
���  �
�����  �
�
��  ������
   (Report WorkSheet) 



 
 
Output File: '���  �  "
���  �����
 . /����  ����  �"������	
�  	  	���  ����������  
({PathTag}) 
Edit RTF File: ���
�����  �  ������  �
�  RTF "
��� . 0������	
���  �  
���
�����	
���  �����
  �����
  
Disk Append: *���  ����  
���	��  (�����  «!
����
 »), ���  	���	�  ���
���  
"������	
���  �����
 , ��	��  �
����  �����  ���
	����  	  ���  ������	�����  
"
�� . ��
��  ���  	���	�  ���
���  ���  "������	
���  �����
 , �����  ����
	
����  
��	��  "
��  �����
 .  
Unicode: "������	
���  �����
  	  "���
��  Unicode 
Lock Value into the {tag/Exp} length: '��  
���	���  ���� , ��
�����  ���������( , 
��
�
����  	  { }, �����  �
���
��  	  ����� , ����  �����  �����  (��������	�  ���	���	 ) 
��  ���� �� , ���  ��������	�  ���	���	  	  { }. 
 
% ����	���  ����  "������	
���  �����
 , ������  �����
 , �����  ��������	
��  
	��
�����  �  ����������  ����������� , �
���������  	  { } ({tag} ���  
{If(tag1>1,1,0)} ). '�����  	  	��
�����( , �
��������(  	  { } ��  ������  ����  
�������	 .   
 
 

��
���  ���  �
����  �  ������� : 
Report( "Disk:Report1.rep") – ��(�
����  �����  �
  ����  
Report( "Prn:Report2.rep", 0) – �
����
�
��  �����  (�����  – ���������  ���
���� : 0 – 
	�����
����� , 1 – !�������
����� ) 
Report( "Pdf:Report1.rep") – ��(�
����  �����  �
�  .pdf 
 
 
�!�
�������  ���  �
�
��  Report: 
/
����
�����  ��������	�  �
����  (Report worksheet) – 32000 
/
����
�����  ��������	�  �����  	  �
�����  (Report worksheet) –  ��  �!�
������  
 
 

13. !�
���  ODBC 
�����  �
�����  �����  IWS �  �����  6, , ��������	
����  &���  �����"��� . 
,��  �����
  �
����� , ������  �
�
��  ODBC 	  ������ , ����(�����  �"������	
��  
��
��
�����  �����"���  Windows ODBC.  
 
����
���  �
�����  �
�
��  ODBC (ODBC WorkSheet) 



 
 
Data Source: �
�	
���  �����"���
  ODBS, �  �������  �����  �����	�������  
�����  �
����� . 
User: ���  ������	
����  ���  ������
  �  6,  
Password: �
����  ������	
����  ���  ������
  �  6,  
Table: �
�	
���  �
�����  	  6,  
Condition: ����  ���  	����
  ���  "�����
���  �
���(  
Status: ���������  ����������  (���
����� ) �  6,  (������	��  ��
�����  – � ���
 ) 
Transaction: ��	������	
���  ��
�����  ���������� , ��
�
����  	  �
����  ���� , 
�����  �
	�� ����  �����
  �
����� .  
Select, Next, Insert, Delete, Update Trigger: ���
���  ���  �
����  �  6,  
 
Tag Name: ���  ���������  ����������  
Column: ���������  ����������  	  6,  (�����
 ) 
 
#
�
�
  ODBC �
����
����  
	���
�������  ���  	������  	  �
������
(  ������
  
(Project ®  Project Status) 
 
�!�
�������  ���  �
�
��  ODBC: 
/
����
�����  ��������	�  �
����  (ODBC worksheet) – 999 
/
����
�����  ��������	�  �����  	  �
�����  (ODBC worksheet) –  4096 
 
 

14. !�
���  Math 
0������	
���  �������	  �
  	���������  �����  ISW Built-in Language 
 
����
���  �
�����  �
�
��  Math (Math WorkSheet) 



 
 
Execution: ���  ������	��  ��
�����  ����������  (	��
�����  ���  �����
��� ), 
��
�
����  	  �
����  ���� , ������  �����  	���������� , ��  ��(  ���  ���
  ��
�����  
����������  ��  ��
���  =0. 
Tag Name: ���  ���������  ����������  
Expression: 	��
�����  	����������  (	���������� ) 	  ��������  �
����  ������
 .  
 
�!�
�������  ���  �
�
��  Math: 
/
����
�����  ��������	�  �
����  (Math worksheet) – 999 
/
����
�����  ��������	�  �����  	  �
�����  (Math worksheet) –  32000 
 
 

15. !�
���  Script 
0������	
���  �������	  �
  �����  VB Script 
 
'��  ��������	
���  ��������(  ���������(  	  ������  ������
 , �����  �(  �
�	
����  
����(�����  ����
	���  ���	��  $ ($tag). %���������  ����������  ������
  ������  
����  ��4�	����  (Dim VBtag), �  ���  ��!��  ����  ��������	
��  ������  	  ������
(  
�
���!�  ������
 . 
 
#
����  ������
  – Execution - ���  ������	��  ��
�����  ����������  (	��
�����  
���  �����
��� ), ��
�
����  	  �
����  ���� , ������  �����  	���������� , ��  ��(  ���  
���
  ��
�����  ����������  ��  ��
���  =0. 
 
 

16. Global Script. Graphics Script 
Global Script – ��������
 , 	���	
��
�  ��  ����!�  ���!�!�  VB ������
 . 
%���	  "������  – Call FuncName (parameters) 
#
�
���  "������  – Function FuncName (parameters) 
    
��  ���!�
���  
     End Function 
'����� : '����
�
  �
���(  	  ���������  �  ��  ���   
value=FuncResult(a, b) 
Function FuncResult(a, b) 

FuncResult=a+ b 
End Function 
 
Graphics Script – ������ , 	����������  ���  ��
���  (	  ��������  	���������  �  
���
��	�� ) �
�
��  Viewer-
  (!�
"�������  ������ ): 
Graphics_OnStart(),Graphics_OnWhileRunning(),Graphics_OnEnd (). 



  
 

17. !�
���  Scheduler 
%���������  �������  (����	�� ) 	  �
�
����  �������  	������ . 
 
 ����
���  �
�����  �
�
��  Scheduler (Scheduler WorkSheet) 

 
 
Event: ������� , ���  �������  �����  	��������  �����	��  (	��
����� , ��
�
����  	  
����(  Tag �  Expression)  

·  Clock . ,����	��  �����  	����������  �  �������� , ��
�
����  	  ����  Time 
(00:01:00 – �
����  ������ ) 

·  Calendar . ,����	��  �����  	��������  	  ��
�
����  	  ����  Date ����  �  	  
��
�
����  	  ����  Time 	���� . '��  �������	��  	  ����  Date �
�� , �����	��  
�����  	����������  �
����  ����  	  ��
�
����  	  ����  Time 	���� . 

·  Change . ,����	��  �����  	��������  ���  ���������  ��
�����  ����������  
(���!!��
 ) ��
�
����  	  ����  Trigger 

 
Disable: ���  ������	��  ��
�����  ����������  	  �
����  ����  	���������  
�����	��  �
�
��  Scheduler �����  �
������� . 
 
�!�
�������  ���  �
�
��  Scheduler: 
/
����
�����  ��������	�  �
����  (Scheduler worksheet) – 999 
/
����
�����  ��������	�  �����  	  �
�����  (Scheduler worksheet) –  32000 
 
 
 

18. Event 
$�(�
�����  �������  ������  (���������  ��
�����  ���������� , ��������  �  
�
������  &��
��	 , � ����  �  �� .) 	  "
��  "���
�
  evYYMMDD.evt, �  �����
�����  
�(  	  ��4����  Alarm/Event control. 
 
 
����
���  �
�����  Event 



 
 
Enable event logger: '��  
���	���  ����  (�����  «!
����
 ») ��������  

"������	
���  �������  �  ��(�
�����  �(  	  "
��  
Disable: '��  ������	��  ��
�����  ����������  	  �
����  ���� , �����������  

"������	
���  �  ��(�
�����  ������� . 
Security System: ��(�
�����  �������  �������  �����
������  IWS (Log on/Log off 

������	
����� , ���������  �
���� , �������	
���  ������	
�����  �  �� .) 
Display: ��(�
�����  �������  �������� /�
������  &��
��	   
Recipe: ��(�
�����  �������  "������	
���  �������	  
Report: ��(�
�����  �������  "������	
���  ������	  
Custom Messages: ��(�
�����  ������� , �"������	
���(  �  �������  "������  

SendEvent( strEvent) 
System Warning: ��(�
�����  
	
�����(  �������  (� ���
  ����
	��  email, 

�������  �
  0)  
Tag: ��(�
�����  �������  ���  ���������  ��
�����  ���������� , ��
�
����  	  ����  

Tag Name, �
  	�������  ���� ��  ��
�����  ��
�
���!�  	  ����  Dead Band , �  
������� , ��
�
����  	  ����  Message. $��������  	  ����  Massage �����  ����  
�
�  ������� , �
�  �  	��
������  �  ��������	
����  ���������( , �
���������  	   
{ }. $��������  "����������  	  ASCII "���
�� . /
����
�����  ��������	�  
�����  	  �
�����  – 4096. 

 
 

19. #���	���  
�����"���  ���  �����
  �
�����  �  ��������	�� . 
 
#
�
�
  ��
�	��
  �
����
����  
	���
�������  ���  	������  	  �
������
(  
����������  (Project ®  Project Status) 
 
,��
	�����  ��
�	��
  	  ������  

1) %��
��
  Comm->Drivers ��
	��  �������  �� �  Add/Remove Drivers. 
2) % ���	�	 ����  ����  	�������  ��  �����
  ��
�	��  �  ��������	� , �  �������  

����(�����  �	��
����  -> Select ->Ok 
 
+
�������  �
�
�����	  ����������  �  ��������	��  



(%��
��
  Comm->Drivers ��
	��  �������  �� �  Settings) 

 
Connection Type: ���  ����������  �  ��������	��  – Direct (�������	
�������  
���������� ), TCP/IP, Modem, UDP 
Serial Port: �
�������  ����
  ���  �������	
�������  ���������� . % ����
�  
	����
  ����������  ��  TCP/IP ���  UDP 	  ��
��!�  �����  �����
����  �
�������  
����  (Network) 
Advanced: ��������������  �
�������  ����������  

 
 
 
Main Driver Sheet 
 
����
���  �
�����   

 
 



Disable: '��  ������	��  ��
�����  ����������  	  �
����  ����  �����  �
���(  �  
��������	��  �����  �
������  
Read Completed: #�
�����  ���������� , ��
�
����  	  �
����  ���� , �����  
��	������	
��  �����  �����
���  ����
  ������  �
���(  �  ��������	
  
Read Status: % ���������� , ��
�
����  	  �
����  ���� , �����  	��	�
���  
�������
�  ������  �
���(  (� ���
  ������ ) 
Write Completed: #�
�����  ���������� , ��
�
����  	  �
����  ���� , �����  
��	������	
��  �����  �����
���  ����
  �
����  �
���(  	  ��������	�  
Write Status: % ���������� , ��
�
����  	  �
����  ���� , �����  	��	�
���  
�������
�  �
����  �
���(  (� ���
  �
���� ) 
Min/Max: �����
�����  (�
����
����� ) ��
����� , �������  �����  ������
��  
��������
� , ��
�
��
�  	  ����  Tag Name 
 
Tag Name: ���  ���������  ����������  
Station: ��
����  (
����  ��������	
  	  ���� ) 
I/O Address: 
����  ����������  	  ��������	� , �  �������  �����(����  �����  
�
�����  
Action: �����	��  ���  ������  �
����� : Read, Write, Read+Write. (#
����  
�����	������  ���  ���������  ��
�����  ���������� ) 
Scan: )���	�� , ���  ������(  	����������  ������  �
���(  (Screen – ��������
�  ��  
�����
 , ������	���  �
  �������� , 	  �
����  ������  &��
�� ; Always – ����������  
���������  ������ ) 
Div/Add: �
���
��������  ����
���  �
�  �����������  �
�����  (tag= val/Div + Add) 
 
/
����
�����  ��������	�  �����  	  �
�����  (Main Driver Sheet) = 4096 
 
 
Driver Sheet 
 
����
���  �
�����   

 
 
Increase Priority: ���������  ������ /�
����  �
���(  �
���!�  ��
�	�� - ��
  	  

�������  �
  ������ /�
����  �
���(  ��  ���!�(  ��
�	�� - ���	 . 



Read Trigger: ���  ���������  ��
�����  ���������� , ��
�
����  	  �
����  ���� , 
�����  �����	�����  ������  �
���(  ��  ��������	
  

Enable Read when Idle: ���  ������	��  ��
�����  ���������� , ��
�
����  	  
�
����  ���� , ������  �
���(  �����  �����	�������  ���������� . 

Read Completed: #�
�����  ���������� , ��
�
����  	  �
����  ���� , �����  
��	������	
��  �����  �����
���  ����
  ������  �
���(  �  ��������	
  

Read Status: % ���������� , ��
�
����  	  �
����  ���� , �����  	��	�
���  
�������
�  ������  �
���(  (� ���
  ������ ) 

Write Trigger: ���  ���������  ��
�����  ���������� , ��
�
����  	  �
����  ���� , 
�����  �����	����
  �
����  �
���(  	  ��������	�  

Enable Write on Tag Change: ���  ������	��  ��
�����  ���������� , ��
�
����  
	  �
����  ���� , �
����  �
���(  	  ��������	�  �����  �����	������  ���  
���������  ��
�����  ����������  

Write Completed: #�
�����  ���������� , ��
�
����  	  �
����  ���� , �����  
��	������	
��  �����  �����
���  ����
  �
����  �
���(  	  ��������	�  

Write Status: % ���������� , ��
�
����  	  �
����  ���� , �����  	��	�
���  
�������
�  �
����  �
���(  (� ���
  �
���� ) 

Station: ��
����  (
����  ��������	
  	  ���� ) 
Header: �
�
�����  
����  ���  ���
�����  �  ��������	�  (����	���
����  ���  

�
���!�  ���
  ��
�	���	 ) 
Min/Max: �����
�����  (�
����
����� ) ��
����� , �������  �����  ������
��  

��������
� , ��
�
��
�  	  ����  Tag Name 
 
Tag Name: ���  ���������  ����������  
Address: 
����  ����������  	  ��������	� , �  �������  �����(����  �����  �
�����  
Div/Add: �
���
��������  ����
���  �
�  �����������  �
�����  (tag= val/Div + Add) 
 
�!�
�������  ���  ��
�	���	 : 
/
����
�����  ��������	�  �
����  ��
�	���	  (Driver sheet) – 9999 
/
����
�����  ��������	�  �����  	  �
�����  (Driver sheet) –  4096 
 
 
NOTE: ���  ����������  �  TWCAT �
  ��
������  �
 ��� , ����(�����  ��������  	  <InduSoft Web 

Studio Folder>\Bin\ ���������  "
��� : 
�� \TcAdsDll\AdsDll.dll 
�� \TcAdsDll\TcAdsDll.dll 
�� \TcAdsDll\TcAdsTest.exe 
�� \TcAdsDll\TcAmsRemoteMgr.exe�
 
 

20. OPC client 
0������	
���  �����"���
  �����  �����������  IWS �  OPC Server-��  (���	�����  
IWS �����������  �  ��������	
�� , �������  	�����
��  �
�  OPC Server), ���  �����
  
�
����� .  
'����  ��������	
����  OPC Client-
  ����(�����  ���
��	���  �  �
�������  OPC 
Server �
  �
 ��� , �
  �������  �
������  ���������� . 
 
OPC Client �
����
����  
	���
�������  ���  	������  	  �
������
(  ����������  
(Project ®  Project Status) 
 
 



����
���  �
�����  OPC  

 
 
Server Identifier: +
�	
���  OPC Server-
 , �  �������  �����(����  ����������  
Disable: ���  ������	��  ��
�����  ���������� , ��
�
����  	  �
����  ���� , �����  

�
�����  �  OPC Server-��  �����  �
������  
Read Update Rate (ms): �������� , �  �������  �����  ����	������  �
���� , 

�����
����  ��  ���	��
  
Percent DeadBand: ���  ���������  ��
�����  ����������  �
  	�������  (	  %) 

��
�
����  	  �
����  ���� , �
����  ��
�����  �����  �����
��  �
  ���	��  
Status: ���������  �	���  �  ���	����  
Remote Server Name: �
�	
���  ��
�����!�  OPC Server-
  
Read after writing: "�
!  ����������!�  	���������  ����
���  (�
����  -> ������ ) 
Accept Tag Name in the Item column: '��  
���	���  ���� , ��
�����  �&!
 , 

�
��������!�  	  { }, 	  ����  Item �����  	��������
����  �
�  ���  ����������   
OPC ���	��
 . 

 
Tag Name: ���  ����������  
Item: ���  ����������  OPC Server-
  
Scan: )���	�� , ���  ������(  	����������  ����	�����  �
���(  (Screen – 

��������
�  ��  �����
 , ������	���  �
  �������� , 	  �
����  ������  &��
�� ; 
Always – ����������  ���������  ����	����� , ��  ��������� , ��
�
����  	  ����  
Read Update Rate) 

Div/Add: �
���
��������  ����
���  �
�  �����������  �
�����  (tag= val/Div + Add) 
 
�!�
�������  ���  OPC Client: 
/
����
�����  ��������	�  �
����  ��
�	���	  (OPC Client sheet) – 999 
/
����
�����  ��������	�  �����  	  �
�����  (OPC Client sheet) –  4096 
 
 

21. OPC Server 
IWS �����  	�����
��  	  ����  OPC Server-a. IWS ��������	
��  ������  OPC 
Server-
 , �
��	
����  Studio.Scada.OPC. 
1���  ������  
	���
�������  �
����
���� , ��!�
  �����  OPC Client (���
�����  ���  
��
������ ) ���
����  �����������  �  Studio.Scada.OPC ���	���� . OPC Client 
�����  ������	
����  �
�����  ��  �������  (IWS) ���������  OPC �����"��� . 
OPC Server �����  �
�������  ��  ������  (
	���
�������  ���  	������ ) ���������  
�
�������  Project ®  Project Status. 



22. TCP/IP client – server 
/�����  IWS ���	�������  �����  �
�����  �����  ������������ , ���������  
TCT/IP �������� . 
,��  ��������	
���  ����������  ��  TCP/IP ����(�����  �
�������  �  �
�������  
������  TCP/IP Client �  Server. 
TCP/IP Server �
����
����  
	���
�������  ���  	������  	  �
������
(  ����������  
Project ®  Project Status. 
,��  �
�������  TCP/IP Client-
  ������������  ���"�!��
���  IWS (	  �
��
���  Comm), 
	  �������  ��
��	
����  IP 
����  ���	��
  �  ���������� , �������  �����  ��������  
��  ���� . 
 
 
����
���  �
�����  TCP/IP Client 

 
 
Connection Status: $�
���  ����������  �  TCP/IP Server-��  
Disable: ���  ������	��  ��
�����  ���������� , ��
�
����  	  �
����  ���� , �����  
�
�����  �
������  
Server IP Address: IP 
����  TCT/IP Server-
  
Send Fields: ���  
���	���  ���� , ������  TCP/IP Client �  Server �����  
������	
����  ��  ������  ��
�������  ���������( , ��  �(  ��
�������  �(  �����  (Min, 
Max, Ack, HiLimit �  �� )    
 
Tag Name: ����������  ������  �
  ���
�����  �
 ���  
Remote Tag: ����������  ������  �
  ��
������  �
 ���  
* *���  ����
  ���������(  �
  ���
�����  �  ��
������  �
 ���  ��	�
�
�� , ����  
Remote Tag �����  ��  �
������� . 
 
�!�
�������  ���  TCP/IP Client: 
/
����
�����  ��������	�  �
����  ��
�	���	  (TCP/IP Client sheet) – 999 
/
����
�����  ��������	�  �����  	  �
�����  (TCP/IP Client sheet) –  4096 
 
 

23. Security.  �
���	���
�  �  ������  
�!�
������� , �
��
��	
����  �
  	���������  ������	
�����  ���
��  �  �
�
�  	  
�
��������  �������  (Runtime) �  	  �����  �
��
�����  (Development). 
 
$�����	���  255 ���	���  ������
  – ����� , ��
��	
����  	  ����  Security 	  
�	����	
(  ��4���
  IWS (���
��
 , 		�� /	�	��  �����
 , �	����	
  	  ��4����  



Alarm/Event control �  �� .). $	����	�  ��4���
  ��������  ������	
���� , ����  �!�   
���	���  ������
  ����
������  !�
���
�  ������
  ������	
���� . 
 
%���������  �
�
� , �
��� ����(  ������	
���� , 	����
����  	  ��
��!�  �
������  
������
  !�����  ������	
����� . 

 
 
Group Account: +
�	
���  !�����  ������	
�����  
Security Level: !�
����  ��
	  ������
  !�����  ������	
�����  
Engineering (Runtime) Access: $�����  �
�
� , 	���������  ������(  �
��� ���  
!�����  ������	
�����  ���  �
��
�����  ������
  (	  �
���
����  ���������� ) 
 
New: ���
	�����  ��	��  !�����  ������	
�����  
Delete: ��
�����  !�����  ������	
�����  
Advanced: ��������������  �
�������  !�����  ������	
�����  
 
% �
����  !�����  ������	
�����  ������	���  ������  ������	
����� , ���
�
���(  
��
	
��  �
����  !����� . '�����	
����  ������"���������  ������  �  �
����� . 
 
,�
��!  ����
���  ������	
���� : 

 
 
,��  ����
���  ������	
�����  	  ������  Runtime, ������������  ���
��
  
CreateUser( strUserName, strGroup, strPassw, strUserFullName ). 
 



,��  ��������
  	��(  ������	
�����  (����
���(  	  �����  �
��
�����  �  	  Runtime-� ) 
������������  ���!�
��
  ExtUser.exe (<InduSoft Web Studio Folder>\Bin\). 
 
 
 

24. "�������  

�  ���
����  Web ���������	������  �������  
Web ���������	
���!�  ������  – ���������� , �
��������  �
  ���
�����  
�
 ��� , �  ��������  �����  ���
������  ��
����� , ���������  ��������  TCP/IP 
(������  �������� ) 
 
+
  ���	���  (�
 ��� , �
  �������  �
������  ���������� ) ����(����� : 

·  $���
��  	  �������  .html ���
����  &��
��	  (File -> Save as Html) 
·  #
�������  TCP/IP Server (
	���
�������  ���  	������  	  �
������
(  

����������  Project ®  Project Status) 
·  #
�
��  	  �������   IP 
����  ���	��
  : "������  SetWebConfig( strServerIP) 

���  	  �
������
(  ����������  Project->Settings->Web->Data Server IP 
Address 

·  +
�������  �
  ����������  �����  80 �  ����  ������  IWS (��  �����
���  1234) 
·  #
�������  Web Server  

 
+
  �������  (�
 ��
 , �����
�  �����  ��
�����  ���
�
����  �  ���	��� ) ����(����� : 

·  +
�����  MS Internet Explorer 6.0 ���  	� �  
·  )��
��	���  ActiveX ���������  IsSymbolControl.ocx 
·  �
��� ���  ���
��	��  ActiveX ����������	  

 
 

25.  ���	�
���  (Translator) 
0������	
���  �
�����  ����	��
  ���	  �  "�
�  �  ����!�  ����
  �
  ���!�� , ���  
	����������  ��������	
��  	  ����������  ���������  �
������(  �����	 .  
�
����
  "����������  	  ����  Translation Editor (Tools -> Translation Editor) �  
��(�
������  	  	���  .csv "
��
 . ,��  ��������	
���  ����	�����
  	  ���������� , 
����(�����  ��
�
��  ����  �  "
���  (Project->Settings->Options->Translation File 
Name) �  �
��� ���  ����	�� , ����
	�	  «!
����� » 	  ����  Enable Translation. 
 


